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Preface
Welcome to the Oracle Insurance Insight Administration Guide. This guide presents the 
information you will need to manage data and user accounts in Oracle Insurance Insight (OII) 
using the administrative tools of Oracle Business Intelligence Enterprise Edition (OBIEE).
This is not a complete system administrator’s guide for OBIEE. The purpose of this manual 
is to describe the basic administrative duties that you will need to perform in order to 
maintain the data in OII.

VERSION
This manual corresponds to Oracle Insurance Insight (OII) version 6.0.

INTENDED AUDIENCE
This manual is intended for experienced system administrators with advanced knowledge of 
OBIEE and OII. 

RELEVANT ORACLE DOCUMENTATION
For complete documentation on OBIEE and its components, please go to the documentation 
section of the Oracle website to consult the following manuals:
• Oracle Business Intelligence Server Administration Guide
• Oracle Business Intelligence Presentation Services Administration Guide
• Oracle Business Intelligence Answers, Delivers, and Interactive Dashboards User 

Guide

The entire documentation set for OBIEE can be found on the Oracle Documentation page on 
the Oracle Technology Network at:
http://www.oracle.com/technology/documentation/index.html
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CUSTOMER SUPPORT
 If you need assistance with Oracle Insurance Insight, please log a Service Request using My 
Oracle Support at https://support.oracle.com.
Address any additional inquiries to:
Oracle Corporation
World Headquarters
500 Oracle Parkway
Redwood Shores, CA 94065
U.S.A.

Worldwide Inquiries:
Phone: +1.650.506.7000
Fax: +1.650.506.7200
oracle.com

BLOCKED::http://metalink.oracle.com/
BLOCKED::http://metalink.oracle.com/
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Chapter 1

OII Administrator’s Duties
Oracle Insurance Insight (OII) is a comprehensive business intelligence system created 
exclusively for the Property and Casualty (P&C) insurance industry that provides the 
following advantages: 

• Consolidates data from multiple, disparate source systems to provide a strategic 
enterprise-wide view across operating units. 

• Provides an underlying data model constructed specifically for the P&C insurance 
industry.

• Delivers information management, reporting and advanced analytics to end-users 
through the OBIEE interface.

• Accommodates all P&C lines of business and all states/provinces in the U.S. and 
Canada.

BASIC ADMINISTRATIVE TASKS
The OII system administrator is responsible for performing the following basic duties 
outlined in the table below. These tasks will be performed using components of the OBIEE 
and separate OII applications.

Table 1: Basic Administrative Tasks

Task Performed Using this Application:

• Add users to the OII Repository
• Edit the OII Repository

• OBIEE Administration Tool

• Add users to groups • OBIEE’s Presentation Services Administration page

• Manage Load Manager • Load Manager is a job scheduler designed to perform automated data 
loads into OII. 

• Load Manager is a separate Java based application that must be 
installed, configured, and run outside of the OBIEE system. 

• Instructions for installing and setting up Load Manager can be found in 
the Oracle Insurance Installation Guide. 

• For information on configuring and using Load Manager, refer toChapter 
5: Using Load Manager.

• Create an ODBC Data Source to the 
OBIEE Server

• Control Panel>Administration Tools>Data Sources on your desktop
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ADMINISTRATOR PREREQUISITES
Any system administrator should meet the following prerequisites:

• Strong Technical Skills

• Understanding of business data 

• Understanding of OBIEE

• Understanding of OII 



3

Chapter 2

Managing the OII Repository
This chapter describes the following OII administrative duties:

• Logging into the OBIEE Administration Tool

• Adding new users to the OII Repository

• Removing objects from the OII Repository

OPENING THE OII REPOSITORY
To open the OBIEE Administration Tool: 

1. From the Start menu select Oracle Business Intelligence > Administration. 
 
The Administration interface workspace opens:

Figure 1: OBIEE Administration Workspace
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2. Select File>Open from the menu or click on the Open icon. The login dialog box opens.

Figure 2: Open OII Repository (AnalyticsWeb)

3. Enter the Administrator ID and password

4. Select “AnalyticsWeb” and press OK. The OII repository opens.

Figure 3: OII Repository in the OBIEE Administration Tool

The OII Repository contains three layers.

• Presentation Layer – this pane represents the physical structure of the OII repository. 
This layer shows each mart in the repository. When you expand a mart it will display a 
list of all metrics and fields contained in the mart. This is the layer you will be most 
concerned with and will be the one that you edit directly.

• Business Model and Mapping layer – this pane represents the logical structure of the 
information in the OII repository
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• Physical Layer – this pane represents the physical structure of the data sources to which 
the OBIEE Server submits queries. 

ADDING A NEW USER TO THE OII REPOSITORY
To add a new user to the OII Repository:

1. From the top menu, select Manage>Security. The Security Manager appears.

Figure 4: Security Manager

2. From the menu, select Action>New>User. The Add New User screen opens:
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Figure 5: Add New User Screen

3. Enter the information at the fields on this screen as required. 

4. Check the appropriate group(s) that you want to assign to the user. There are five OII 
groups:

• Actuary
• Claims Management
• Executive
• Production
• Underwriting

Note The administrator can also add users to groups within OII. 
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5. Click OK after you have entered the user information and selected the groups. 

Figure 6: New User Information

6. Close the Security Manager.

7. On the top menu, click on the Checkin icon (the one with the red arrow).

8. Save the OII repository.

9. Close the OII repository and exit from the Administration Tool.

10. Open the Oracle Business Intelligence screen for OII and login as the Administrator.

11. Log out of the OBIEE.

12. Log into OBIEE as the new user.

13. Log out.

The new user has now been added to the OBIEE.
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EDITING A USER
To edit a user in the OII Repository:

1. From the top menu, select Manage>Security. The Security Manager appears.

Figure 7: Security Manager

2. In the left frame click on the Users icon. The accounts in the frame of the right will be 
sorted alphabetically by user. 

3. Double-click on a user. A dialog box will appear and ask you if you want to check out 
the selected user.

4. Select Yes and the User box opens:
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Figure 8: Edit User

5. Edit the user’s information and click the OK Button when you are through. 
 
The checkout icon on the top menu will become active.

6. On the top menu, click on the Checkin icon (the one with the red arrow).

7. Save the OII repository.

8. Close the OII repository and exit from the Administration Tool.

9. Open the Oracle Business Intelligence screen for OII and login as the Administrator.
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REMOVING A METRIC OR FILTER FROM THE REPOSITORY
On occasion, a need may arise to remove metrics or filter fields from the OII repository that 
are not applicable to users. The administrator can remove any metrics or fields from the 
Presentation Layer of the OII Repository so that they will not appear within the OBIEE. 

To Delete a Metric or Filter:
1. Expand the mart and category containing the metric or filter you want to delete.

2. Highlight the metric or filter and select Edit>Delete from the top menu. 
 
A dialog box will appear asking if you want to check the item out.

3. If you’re sure then click Yes in the dialog box. 
 
The item will be deleted and the Checkin icon on the menu will become active.

4. Click on the Checkin icon.

5. Click the Save icon.

6. Close the repository and exit the Administration Tool.

7. Log into OBIEE and go to the mart that contained the metric or filter. The deleted item 
will no longer appear in the interface.

Note The removal of any metric or filter from the OII Repository is permanent!
Before you delete any object from the Presentation Layer, ALWAYS make a backup of 
the OII Repository. 
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Chapter 3

Managing User Accounts in OBIEE
Once a user has been added to the OII Repository, the administrator will need to add them to 
the same group within OBIEE Presentation Catalog through the OBIEE Presentation 
Services Administration page within the OBIEE GUI.

OPENING THE OBIEE ADMINISTRATION PAGE
1. Log into OBIEE as an Administrator.

Figure 9: The OBIEE Home Page
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2. Click on Settings>Administration.

Figure 10: Administration Menu in OBIEE

The OBIEE Presentation Services Administration page opens:

Figure 11: OBIEE Presentation Services Administration

This screen allows you to manage various aspects of the OBIEE interface. For our intents and 
purposes, this document only discusses the features that relate to managing user accounts. 
For a comprehensive discussion of the OBIEE Presentation Services Administration screen, 
refer to the Oracle Business Intelligence Presentation Services Administration Guide.
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ADDING A MEMBER TO A GROUP
Users can be assigned to one or more of the five OII groups when they are initially added to 
the OII repository using the Oracle Administrative Tool. After the user is created, you can 
use the Administrative link in OBIEE to assign them to other groups.  
To add a member to a group, follow these instructions:

1. The new user account needs to be logged in at least once prior to this step so that it would 
be available in the Presentation Catalog Users List. Just login as that user with the 
matching password and logout. Then login as the Administrator again.

2. On the OBIEE Presentation Services Administration screen, click the Manage 
Presentation Catalog Groups and Users link under the Activities section.

3. The Presentation Catalog Security: Groups and Users screen opens.

Figure 12: Groups and Users Screen

This screen lists the five OII groups along with the Administrator group. To view all current 
users and groups in alphabetical order, click on the Show users and groups link:

Figure 13: All Current Users and Groups in the System
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4. Click on the  icon in the row of the group that you want to add a user to. For this 
example we will add a member to the Underwriting group.

5. The Edit Catalog Group screen opens. 
 
The Group Membership section of the screen lists all of the current members of the 
selected group. In the figure below the Underwriting group has two other groups as 
members: Claims management and Executive. This means that all members of these two 
groups also belong to Underwriting.

Figure 14: Edit Catalog Group Screen

6. Click on the Add New Member link. 

The Add Member to Group screen opens. 

Figure 15: Add Member to Group Screen
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7. Click on the Add link in the row of the group or user that you want to add to the group. 
 
You will be returned to the Edit Catalog Group screen. Under the Group Membership 
section you will see the new user under the list of members.

Figure 16: User is Added to the Group

8. Click the Finished button in the right hand corner of the screen. You will be returned to 
the Presentation Catalog Security: Groups and Users screen.

9. Click on the Finished button on this screen. You will be returned to the OBIEE 
Presentation Services Administration Screen. 

10. Click Close Window to close this window.



Chapter 3 – Managing User Accounts in OBIEE

16

DELETING A MEMBER OF A GROUP
To delete a member from a group, follow these instructions:

1. Select the Manage Presentation Catalog Groups and Users link on the OBIEE 
Presentation Services Administration screen to open the Presentation Catalog 
Security: Groups and Users screen.

Figure 17: Presentation Catalog Security: Groups and Users Screen

2. Click on the  icon in the row of the group that contains the user that you want to 
delete. The Edit Catalog Group screen opens.

3.  Under the Group Membership section of the screen, click the  icon in the row on the 
member. The screen will refresh and the user will be removed from the list.

4. Click the Finished button. You will be returned to the Presentation Catalog security: 
Groups and Users screen.

5. Clicked the Finished button on this screen. You will be returned to the OBIEE 
Presentation Services Administration Screen. 

6. Click Close Window to close this window.
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Chapter 4

Creating an ODBC Data Source for BI Server
OII requires an ODBC data source to connect to the OBIEE Server. This appendix walks you 
through the steps to configure a data source. There are a variety of data source interfaces 
available but for this example we will use an ODBC configuration to MS SQL 2005 using 
the “Insight” data source name.

1. Open the ODBC Data Source Administrator from Control Panel>Administrative 
Tools.

Figure 18: ODBC Data Source Administrator
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2. Click the System DSN tab. The following screen appears.

Figure 19: System DSN Tab

3. Highlight “AnalyticsWeb” and click the Add… button to add a data source available to 
all users on the computer. The following screen appears.

Figure 20: Creating a New Data Source
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4. Select SQL Native Client and click the Finish button. The following screen appears.

Figure 21: Naming New Data Source

5. Enter Insight for the “Name” and fill out the appropriate host name for your SQL 
database server. 

6. Click the Next > button. The following screen appears.

Figure 22: Setting SQL Server Authentication for New Data Source

7. Select the With SQL Server Authentication… radio button and enter a login ID and 
password. 
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8. Click the Next > button. The following screen appears.

Figure 23: Setting Default for New Data Source

9. Select the default database for your database from the drop down menu. 

10. Click the Next > button. The following screen appears.

Figure 24: A New Data Source

11. Click Finish. The following message screen appears.
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Figure 25: Testing New Data Source

12. Click Test Data Source… to test the data source. A successful test message similar to 
this one appears. 

Figure 26: Successful Data Source

13. Click OK to complete the creation of the data source.
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Chapter 5

Using Load Manager
The steps below provide an outline of the process to set-up, configure and run a Load 
Manager instance.  
The first three items are required to set-up Load Manager and are performed one time per 
installation. 

• Setup database tables.

• Install & configure the Load Manager Engine as a Windows Service.

• Install & configure the Load Manager GUI application on the Application Server.  

• Login to the Load Manager application.

• Define the Jobs along with any attributes, such as, sequential, durable, scheduler string 
and scheduler start / stop time.

• Define the Job Steps and corresponding Job Step parameters.

• Assign defined Job Steps (newly defined or existing jobs).

• Start the Job.

• Monitor the Job.

USING THE LOAD MANAGER GUI
Once you have completed the installation of Load Manager you are now ready to set-up the 
jobs.  There are three main components to setting up jobs in Load Manager:

• Define the Job

• Configure the Job

• Execute the Job

To set up a job, the job must first be defined by using the interface to set up the following job 
tables: Job_Step, Job_Step_Assignment and Job_Step_Parameter.  After defining the job, 
the starting parameter must be defined either on a scheduled basis (specific day, month, 
time) or based on a trigger.  Finally, the job must be set-up to execute on either a one-time 
basis or to run continuously based upon the job schedule.  Each of these items will be 
explained in further detail below.

http://<machine>/load/Load.do
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JOB SUMMARY
To use the Load Manager GUI, point your browser to http://<machine>/load/Load.do to see 
the Job Summary screen pictured below.

Figure 27: Initial Job Summary Screen

Base Configuration of Jobs
This version of Load Manager is delivered with the following base configuration of pre-
defined jobs:

Note A Job with the Job Id 1 is reserved for refreshing all Load Manager jobs.  It can be 
associated with any type of trigger or with any scheduler.

Table 2: Load Manager Jobs  

JOBS DESCRIPTION

Daily Jobs

Daily Database Load Daily job to load all lines of business daily and common marts (CSP, CXDP, 
CMP, DCSP, DCXDP, CDDP)

Monthly Jobs

Monthly Common Datamarts Monthly job to load all lines of business common marts (CSP, CXDP, CMP)

Monthly Database Load  Monthly job to load all lines of business monthly and common marts (CADP, 
CPDP, DFDP, HODP, PADP, UPDP)
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Buttons
There are several buttons on the screen:

• New: Creates a new job.

• Duplicate: Duplicates a new job from an existing job.  This feature saves time when 
setting up similar jobs.  

• Delete: Deletes an existing job, if the job is not running.  All corresponding job steps will 
also be deleted, if the steps are not associated with any other jobs.

• Start: Starts a job.  If a job does not have a trigger or scheduled run time you can start it 
immediately from this screen.  Otherwise, it will be executed based on the specified 
settings.

• Refresh: Refreshes all jobs.  Each time a job is modified, it will be automatically updated 
in the job scheduler.  However, the refresh button can be used for any reason to force an 
update.

Menu Items
The menu items along the left side will be described in more detail as the job setup is 
explained:

• All Jobs: This will bring you back to Job Summary page.

• Job Steps: This will list all available Job Steps.

• Triggers: This will list all available Job Triggers.

• Monitors

On Request Jobs

On Request Data Profiler On request job to execute data profiler only

On Request Refresh Application 
Descriptions

On request job to refresh application descriptions

On Request Update Default 
Descriptions

On request job to translate all “Unknown” descriptions to equal their code 
values

On Request - Back Out Last Day Backout job for the last day loaded into the warehouse and marts

On Request - Back Out Last Month Backout job for the last month loaded into the warehouse and marts

Datamart Specific Loading Jobs

Load Corporate Detail  Load only CXDP datamart

Load Corporate Summary Load only CSP datamart

Table 2: Load Manager Jobs  (Continued)

JOBS DESCRIPTION
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• Currently Running: Lists all running jobs.

• Last Hour: Lists all jobs started within the last hour.

• Last Day: Lists all jobs started within the last day.

• Specified Range: Lists all jobs in the user specified range.

NEW/EDIT JOB
To create a new Job or edit an existing Job, follow the steps below.  To create a new Job, 
click on the button “New”.

Figure 28: Creating a New Job

Job Attributes
• Job Name: Enter a Job Name. This field has a limitation of 50 characters. A Job with the 

Job Id 1 is reserved for refreshing all Load Manager jobs. It can be associated with any 
type of trigger or with any scheduler.

• Type

• Sequential: All jobs defined as sequential will be executed one after another.

• Durable: All jobs without durable specified will be executed only once. Otherwise, 
the job can be executed again and again based on the trigger and scheduler settings.
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• Scheduling Information

• Start Date: Start Date in the format of MM/DD/YYYY.  No start date means start 
at the earliest possible date.

• End Date: End Date is in the format of MM/DD/YYYY. No end date means it has 
no expiration date for execution.

• Start Time: Start Time is in the format of HH:MM. No start time means start at the 
earliest possible time.

• End Time: End Time is in the format of HH:MM. No end time means the end of the 
day.

Scheduler Settings (Cron String)
This is the most complicated portion of setting up a job. This will only be needed if the job 
is to be executed on a specific time schedule. Click on “Edit Settings” next to “Cron Strings” 
to access the Cron String Setting page. The screen will default to “Seconds”.

Figure 29: Editing Cron String Settings – Advanced Tab
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If you know how to construct a cron string, use the “Advanced” tab to simply enter the final 
string, instead of following each step described in the Scheduler Settings section.

Figure 30: Edit Cron String Settings – Seconds Tab
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Click on any of the seconds and the job will be setup to execute on the selected second.  
Marking a box brings up more options and displays the Cron String in the Cron String 
Preview area along the top of the screen:

Figure 31: Trigger Options for Seconds
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The Trigger Options setting allows the job to be executed not only on the selected second, 
but to also be invoked on a recurring basis (for example, trigger job to start every 8 seconds 
until 50 seconds is reached). Mark the check box under Trigger Options and select the proper 
interval values, if desired.

Figure 32: Cron String Preview

The Cron String Preview area is updated at the top with the values entered.  
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Repeat this same process with Minutes and Hours.  The common settings are Seconds, 
Minutes, Hours and Day of Month. 

Figure 33: Selecting Day of the Month Parameters
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Next, select the ‘Day of Month.’  This option is used when executing jobs on a specific day 
of the month.  Under “Day of Month’, an additional Trigger Option is available to choose 
“Closest weekday (Monday – Friday) in the same month.”  When this is selected, if the day 
of the month checked is a weekday (for example “12”) that day will be used for execution.  
Otherwise, the closest weekday, either earlier or later within the same month, will be used to 
execute the job.

Figure 34: Last Day of the Month Option
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Another option unique to “Day of Month” is the “Last Day of Month Options.”  When this 
option is checked, you can set the Trigger Option as a specific number of days from the end 
of the month you wish to execute the Job.  For example, if you select “2” the Job will execute 
2 days prior to the last day of the month.  Selecting “L” will execute the Job on the last day 
of the month.

Figure 35: Selecting the Month

After you have selected the “Day of Month” select the Month(s).
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For Day of Week, there is a special type of control shown below:

Figure 36: Selecting Day of the Week

Select Day(s) of the Week.  More than one Trigger Options box can be checked to specify 
the week during the month for the Day of Week selected.  If no Trigger Options are checked 
the job will repeat on every Day of the Week selected.
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Job Steps
There are two ways to set up Job Steps:

• On the Job New/Edit page, click on the New button, or

• Click on the Job Steps menu on the left side to see the list of available Job Steps.  Then 
click on New to create new step or click on and existing step to edit it.

Figure 37: Job Steps

Save the Job once the setup is completed for All Job Attributes, Cron String, Trigger, and Job 
Steps. The job will automatically be scheduled for the next run.  If the job does not have an 
associated Cron String or Trigger, it will be executed immediately.
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NEW/EDIT JOB STEP
There are two types of Job Steps for Load Manager to execute and include in a Job.  The first 
type of Job Step is an External Program, which is also the default type when you open the 
New/Edit Job Step page.  The second type is a Stored Procedure.  Any combination of the 
two types of job steps can be used in a job.  There are no limitations on the number of steps.

Step Type – External Programs 
Select ‘External Programs’ as the Step Type and enter a Job Step Name.  The Job Step Name 
is the only required field.  However, to make a Job Step useful you need to provide at least 
two Parameter Types: one DIRECTORY and one COMMAND.  The parameters will let 
Load Manager know both the working folder (DIRECTORY) and the command to execute 
(COMMAND).  This can be a single application as well as a batch file.

Figure 38: External Program Type Job Step
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Step Type – SQL Stored Procedures

Figure 39: Stored Procedure Type Job Step

Select ‘SQL Stored Procedures’ as the Step Type and enter a Job Step Name. You will 
notice that the Step Details and available Parameters Type change based on SQL Stored 
Procedures being selected.  The Job Step Name is the only required field, but the Stored 
Procedure Name must be specified for the Job Step to properly run.
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Figure 40: Setup Input Parameters for Stored Procedure

If you have any parameters, please specify them in the order shown.  Use the up and down 
arrow buttons under the “Order” column to adjust the order of the parameters.  For String 
parameters, you do not need to provide single quotes.  The special characters, single quote 
(‘), exclamation sign (!) and pound sign (#) are prohibited.  If you do not know the type of 
parameter, specify OTHER.
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NEW/EDIT JOB TRIGGER
There are two ways to set up a Job Trigger:

• In the Job New/Edit page, click on New Trigger or Edit Trigger, or

• Click on the Triggers menu on the left side to view the list of available Triggers. Then, 
click on New to create a new Trigger or click on an existing Trigger to edit it.

Figure 41: Setting Up a Job Trigger

On the Trigger New/Edit page, there are two types of Triggers, File Based Triggers and 
Database Based Triggers.  An example of a File Based Trigger is shown below:

Figure 42: File Based Trigger
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To set up a File based Trigger you will need to provide:

• Full File Path: The full file path for the file used as the signal for this file based trigger. 
The file path is referenced as to where Load Manager has been installed. For example, if 
you are using “C:\file.name”, it is located at the C drive on the machine where you 
installed Load Manager.

• Conditions: Could be EXIST, NONEXIST or CHANGED as shown above.  The default 
value is EXIST, which means if Load ManagerSM detects the existence of this file it will 
fire the Trigger invoking the Job associated with the Trigger.  

• Post Trigger Command: This is a command that is executed after the associated Job.  
Normally, a command is used to clear the conditions that fire the trigger.  For example, 
for conditions EXIST, normally the command will be “del” to remove the file.  This will 
prevent the file from triggering the job again by mistake.  Load Manager will 
automatically add the file name to the command to complete it.

For Database Based Triggers, click on the Trigger Type drop down list box and change the 
type to Database based Trigger as shown below:

Figure 43: Database Based Trigger

To set up a Database based Trigger you will need to provide:

• Database Column (Full Qualified): The column name starts with schema and database 
table name, can use * if not specified.

• Condition (Expression in where clause): The Condition is the expression which will 
be put into the where clause in the SQL statement.  For example, the condition could be 
“id=2 and value=’Updated’”.  If any column is mentioned in the Condition it needs to be 
in the database table specified in Database Column (Full Qualified) field.
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• Post Trigger SQL Expression: This is, as the name implies, a post trigger SQL 
expression that is executed.

ASSIGN JOB STEPS
Once the Job Steps have been defined, go back to the Job New/Edit page. If you are entering 
the Job Step New/Edit page from there simply saving the Job Step will return you to the 
correct page.  Otherwise, go to the Job Summary page to assign steps to a job. Click to select 
the job.  At the bottom of Job New/Edit page, there are two lists.  The right side contains a 
list of all available job steps and the left side contains a list of all assigned job steps for the 
current job.  Use the up and down arrow button to change the order of the job steps.

Figure 44: Assigning Job Steps
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START JOB
On the Job Summary page, there is a button called Start.  You can start a job immediately, if 
the job selected does not have an associated trigger or schedule.  Otherwise, the job will be 
invoked when the specified trigger is fired or the job will execute at the scheduled time as 
defined in the setup.

Figure 45: Starting a Job
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MONITOR JOB EXECUTION
After starting a job, you can monitor the job execution process.

Running Jobs
All running jobs are listed with Job Id, Job Name, Time started and Job Status.  The Job 
Monitor also has a multiple page control at the bottom of the page.  If there is more than one 
page (depend on the size of the page, default to 20) of running jobs, they will be broken into 
multiple pages.  By clicking on the proper button, you will be directed to the page you want 
to access.  Also you can jump to the page you like by simply entering the page number.
For running jobs, you have an option to stop a particular execution by clicking the Stop 
button after you select the job to stop.
Also for running jobs, if you click on Run Id, you will be able to check the more detailed job 
step status inside the job.

Figure 46:  Running a Job
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Job Ran Within Last Hour / Last Day
These are convenient shortcuts to view a Job Ran within the last hour or last day.  The 
difference between these options and the one above is that all jobs shown here would have 
already been executed with either a success or failure status.  The Stop button would not be 
available.

Figure 47: Jobs Run Within Last hour or Last Day
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Job Ran Any Time
Use this option if you want to check on an earlier transaction.  If you have a wider range of 
transactions to view, you can use this option to retrieve the job status.

Figure 48: Jobs Run Within a Specific Date Range
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Chapter 6

Integrating Data Profiler with Load Manager
Data Profiler is a Java based utility used to analyze data loaded to the Templates for quality 
and adherence to OII business rules. When Data Profiler is run, exceptions to data conformity 
rules are generated in a PDF report for evaluation.
The {OII}\Applications\DataProfiler directory contains a set of batch files designed to run 
data profiler for Policy and Claims template tables for each line of business.

Figure 49: Data Profiler Batch Files

Load Manager contains a job step configured to run each batch file as an External Program.  
There is a job called “On Request – Data Profiler”, that is configured to run all of the Data 
Profiler job steps.
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When Load Manager executes a Job Step, the corresponding batch file is executed. A PDF 
file is generated in the DataProfiler base directory for each batch that is run. 

Figure 50: Data Profiler PDF Reports

Each step passes or fails in Load Manager after the External Program logic captures and 
analyzes the 0-5 code that Data Profiler outputs. If the output code is 0, then the running 
Load Manager job proceeds to the next sequential step. Any other code that is returned,  
1-5, the step fails and the administrator must check the generated PDF to resolve the 
errors.

MANUAL EXECUTION EXAMPLE
If the automatic execution step is disabled in Load Manager, you can run Data Profiler 
manually.
1. Open CMD window -- (START>Run>cmd)

2. Change directory to "{OII Root}\Applications\DataProfiler\”

3. Type and execute the database name and template name as follows at the command 
prompt line> runDataProfiler server.ct3 PersonalAuto 

where server.ct3 equals the prefix of the properties for the database you want to 
access.

In item 3 above, there are 2 arguments needed to run this program and a third optional 
argument called “Scan Mode” that can be used.

#1:Specify Database connection name/alias. Example: "server.ct3"
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This is the name of the database and its ip address. This name/alias can be created/
modified by editing DataProfiler.properties file.

Example of a connection property:
server.ct3.type=SQL Server 2005 
server.ct3.driver=com.microsoft.sqlserver.jdbc.SQLServerDriver 
server.ct3.user= 
server.ct3.pass= 
server.ct3.url=jdbc:sqlserver://
<db_host_name>;instanceName=<db_instance_name>;databaseName=<db_name> 
server.ct3.functions=false 
server.ct3.autocommit=true

#2: Specify Tablename alias. Example: "PersonalAuto"

This is the name of the template file to be profiled for errors. This name can be created/
modified by editing DataProfiler.properties file.
Example of a tablename property:
validation1.name=PersonalAuto 
validation1.sourcetable=CT3.PERSONALAUTO 
validation1.sourcetablekey=RowNumber 
validation1.ruleset=1

#3. Specify if Data Profiler should be run in Scan Mode by typing –S after arguments #1 
and #2.

Scan mode finds all distinct errors and displays recurring errors (errors that occur on more 
than 1 row within the data template) only once.  An error message will be displayed for each 
distinct error. The Scan Mode option is useful when profiling large data templates and avoids 
displaying an error message for every row encountered.

4. A report in PDF format will be generated at the end of the program in the same directory 
as Data Profiler. This report lists the row number and the column name of all the records 
that do not meet the data rules.  The code setting the data rules is proprietary and should 
not be modified. If Scan Mode has been used, the error report displays the distinct errors 
without row numbers.

Note Sourcetable is the actual template table name highlighted above in yellow.
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DATA CONFORMITY RULES
This table contains examples of some of the rules Data Profiler uses to validate template data.  
There is a validation rule for every column in each data template.  When data does not 
conform to the established rules as set forth in the applicable Claims or line of business 
Properties file, Data Profiler will write the appropriate message to an error report arranged 
by corresponding row number.

Table 3: Data Conformity Rules  

Type Column Name Column Name Business Rule

Single Column BookDate --- Cannot be NULL; mm/dd/yyyy

Single Column CycleDate --- Cannot be NULL; mm/dd/yyyy

Single Column [Policy]EffectiveDate --- Cannot be NULL; mm/dd/yyyy

Single Column [Policy}ExpirationDate --- Cannot be NULL; mm/dd/yyyy

Single Column NewRenewalCd --- Code must equal “N” or “R” (default)

Single Column ActiveCancelledCd --- Code must equal “A” (default) or “C”

Single Column DirectCededAssumedCd --- Code must equal “A,” “C,” or “D” 
(default)

Single Column DeleteCd --- Code can be BLANK (default),  “N”, or 
“D.”

Single Column PolicyNumber --- Cannot be NULL; Must < or = to 
varchar(25)

Single Column RatedDriverCd --- Code must equal “Y” or “N” (default)

Single Column StateCd --- Can be BLANK or Column can contain 
codes from the StateCode Standard 
Codes table. varchar(2).

Single Column ThazarCoverageCd --- Column must contain codes from the 
ThazarCoverageCd Standard Codes 
table.

Single Column ThazarTransactionCd --- Column must contain codes from the 
ThazarTransactionCd Standard Codes 
table.

Cross Column BookDate CycleDate BookDate must be = or > CycleDate

Cross Column CoverageEffectiveDate CoverageExpirationDate CoverageEffectiveDate must be < or = 
to CoverageExpirationDate

Cross Column CoverageExpirationDate [Policy]ExpirationDate CoverageExpirationDate must be < or = 
to [Policy]ExpirationDate
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DATA PROFILER OUTPUT
The sample reports generated by the Data Profiler show:  

• The date/time and template table name at the top of the page.  

• Error messages arranged by corresponding row number.  

• Column name(s) that indicate where the error occurred.  

• Error messages that include the invalid code contained in the column or indicate what 
condition was not met by the value in the column.

• Such as “LE” means “Less Than or Equal To,” 

• Where “GE” means “Greater Than or Equal To”  

• Where “MLE” means MO/YR of the first date (Cycle Date) must be “Less Than or 
Equal To” the MO/YR of the second date (Batch Date)

• The total number of errors at the end of the report.

The report below shows a result report with no errors.

Figure 51: Data Profiler Sample Report

Cross Column CoverageEffectiveDate [Policy]EffectiveDate CoverageEffectiveDate must be > or = 
to [Policy]EffectiveDate

Cross Column CoverageEffectiveDate [Policy]ExpirationDate CoverageEffectiveDate must be < or = 
to [Policy]ExpirationDate

Cross Column CoverageExpirationDate PolicyTermKey All Coverage Expiration Dates must be 
the same for same PolicyTermKey in 
same cycle.

Table 3: Data Conformity Rules  (Continued)

Type Column Name Column Name Business Rule
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GENERAL BUSINESS RULES
Listed below are the basic rules contained within the Data Profiler Properties file. This utility 
reads the various templates and flags rows of data that violate these rules.  Single column 
rules and cross column rules can be added depending on each client’s needs.  After new rules 
are added to the properties file, be sure to add the new rule number to one or both of the 
validation rule sets at the beginning of the properties file. 

Single Column Rules:
1. ActiveCancelledCd must = “A” (default) or “C”

2. Book Date cannot be null and must be date format

3. Cycle Date cannot be null and must be date format

4. DeleteCd must be “N” (default) or  “D” 

5. DirectCededAssumedCd must = “A”, “C”, OR “D” (default to Direct)

6. LossSuitCd must be blank (default), “A”, “B”, “C”, “O”, “P”, “Q”, “R” “S”, “T”, “U”, 
“W”

7. NewRenewalCd must = “N” or “R”(default)

8. Policy Number cannot be null and must < or = varchar (25)

9. [Policy] Effective Date cannot be null and must be date format

10. [Policy] Expiration Date cannot be null and must be date format

11. RatedDriverCd must be “N” (default) or “Y” (auto lines only)

12. StateCd if not blank must be varchar(2). See State Code List attached.  Use alpha 
abbreviations unless otherwise specified by the client.

If the client has chosen to map Thazar codes from source to templates, then these rules also 
would apply to the data.

13. ThazarClaimTransactionCd must = “AC”, “AE”, “AR”, “DC”, “DE”, “DR”, “ED”, 
“FA”, “FC”, “FR”, “LC”, LR”, “NF”, “PL”,  “RC”, “RS”, “SB”, “SC”, “SL”, “SR”, 
“UC”, “UE”, “UR”,  “YC”, “YD”, “YR”, “ZC”, “ZD”, “ZR”.

14. ThazarCoverageCd must = See list of ThazarCoverageCds later in this document.

15. ThazarCoveragePartCd must = “BM”, “BP”, “CA”, “CG”, “CP”, “CR”, “GA”, “GL”, 
“HO”, “IM”, “KK”, “PA”, “PL”, “UC”, “UP”, “WC”

16. ThazarLOBCd must = “BM”, “BP”, “CA”, “CF”, “CG”, “CP”, “CR”, “DF”, “GA”, 
“GL”, “HP”, “IM”, “KK”, “MP”, “PA” (default), “PK”, “PL”, “PR”, “UC”, “UP”, “WC”

17. ThazarLOBSubCd must = See list of ThazarLOBSubCd later in this document.

18. ThazarPolicyTypeCategoryCd must = “AR”, “P”, “S”

19. ThazarPolicyTypeCd must = “I”, “V”

20. ThazarStatusReasonCd must = “AR”, “CF”, “CO”, “IA”, “IC”, “IR”, “NP”, “NR”, 
“OR”, “RW”
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21. ThazarTransactionCd must = “AA”, “AP”, “CF”, “CN”, “CO”, “NB”, “NP”, “RA”, 
“RB”, “RE”, “RP”

Cross Column Rules:
1. Book Date must be = or > Cycle Date

2. Coverage Effective Date must be = or < Coverage Expiration Date

3. CoverageExpirationDates for same PolicyTermKey in same cycle must be same 
(equal), i.e., all Coverage Expiration Dates must be same for same policytermkey in 
same cycle.

4. CoverageExpirationDate must be < or = to Policy Expiration Date

5. CoverageEffectiveDate must be > or = Policy Effective Date

STATECODES:

Table 4: StateCd  

State Abbreviation State Code State Name

"Blank" Unknown

AL 1 Alabama

AZ 2 Arizona

AR 3 Arkansas

CA 4 California

CO 5 Colorado

CT 6 Connecticut

DE 7 Delaware

DC 8 District of Columbia

FL 9 Florida

GA 10 Georgia

ID 11 Idaho

IL 12 Illinois

IN 13 Indiana

IA 14 Iowa

KS 15 Kansas
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KY 16 Kentucky

LA 17 Louisiana

ME 18 Maine

MD 19 Maryland

MA 20 Massachusetts

MI 21 Michigan

MN 22 Minnesota

MS 23 Mississippi

MO 24 Missouri

MT 25 Montana

NE 26 Nebraska

NV 27 Nevada

NH 28 New Hampshire

NJ 29 New Jersey

NM 30 New Mexico

NY 31 New York

NC 32 North Carolina

ND 33 North Dakota

OH 34 Ohio

OK 35 Oklahoma

OR 36 Oregon

PA 37 Pennsylvania

RI 38 Rhode Island

SC 39 South Carolina

SD 40 South Dakota

TN 41 Tennessee

Table 4: StateCd  (Continued)

State Abbreviation State Code State Name
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THAZARCOVERAGECDS:

TX 42 Texas

UT 43 Utah

VT 44 Vermont

VA 45 Virginia

WA 46 Washington

WV 47 West Virginia

WI 48 Wisconsin

WY 49 Wyoming

HI 52 Hawaii

AK 54 Alaska

Table 4: StateCd  (Continued)

State Abbreviation State Code State Name

Table 5: ThazarCoverCd 

Code Description

ADB Accidental Death Benefit

ACCTS Accounts Receivable

ADDIN Additional Insured

ADDLL Additional Liability (BOP Only)

ALEXP Additional Living Expense

APIP1 Additional Personal Injury Protection

ADLLI Advertising Legal Liability

AOP All Other Perils

ACOLL Auto Collision

ACOMP Auto Comprehensive

AHIBI Auto Hired Liability Bodily Injury
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AHIPD Auto Hired Liability Property Damage

LEASE Auto Lease

ALIBI Auto Liability Bodily Injury

ALIPD Auto Liability Property Damage

LOAN Auto Loan

AUMED Auto Medical Payments

AUNBI Auto Non-Owned Bodily Injury

AUNPD Auto Non-Owned Property Damage

AUPIP Auto Personal Injury Protection

ARENT Auto Rental Reimbursement

ATOWG Auto Towing

AUUBI Auto Underinsured Motorist Bodily Injury

AUUPD Auto Underinsured Motorist Property Damage

AUTBI Auto Uninsured Motorist Bodily Injury

AUTPD Auto Uninsured Motorist Property Damage

AL Automobile Liability CSL

BALS B&M Actual Loss Sustained

BAMO B&M Ammonia Contamination

BSBB B&M -Basic- Small Business Policy

BSBR B&M -Broad- Small Business Policy

BCAL B&M Combined Actual Loss Sustained/Extra Expense

BCVE B&M Combined Value Business/Extra Expense

BMCD B&M Consequential Damage

BEXP B&M Expediting Expense

BMEE B&M Extra Expense

BFEX B&M Furnace Explosion

Table 5: ThazarCoverCd (Continued)

Code Description
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BMGE B&M Gross Earnings

BMHS B&M Hazardous Substance

BIUR B&M In Use or Connected Ready For Use

BCCE B&M Limited Coverage Extension

BMRN B&M Marine Equipment Extension

BMOP B&M Ordinary Payroll Expense

BMPD B&M Property Damage

BMSP B&M Service Piping

BSBS B&M -Spoilage- Small Business Policy

BMUI B&M Utility Interruption

BVAL B&M Valued Business

BMWD B&M Water Damage

BAILE Bailees

BAIFL Bailees Customers Floater

BASIC Basic

BASI Basic Group I - Detail

BASII Basic Group II - Detail

BLKAI Blanket Additional Insured

BLKVN Blanket Vendor

BI Bodily Injury Liability CSL

BIPUN Bodily Injury Punitive Damages

BISIL Bodily Injury-Single Limit

BISPL Bodily Injury-Split Limit

BFPRD Broad Form Products

THEFA Broad Form Theft - Loss Away From Premises

BCOL Broadened Collision

Table 5: ThazarCoverCd (Continued)

Code Description
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BRDCV Broadened Coverage

BPIP Broadened PIP

BLDRK Builders Risk

BLDG Building

BAEC Building - Additional Extended Coverage

BEQK Building - Earthquake

BEC Building - Extended Coverage

BFL Building - Fire & Lightning

BAAD Building Alterations and Additions Deletion

BCEG Building Code Effectiveness Grade

BDGNP Building Items Coverage (Named Perils)

BDGIT Building Items Coverage (Special Coverage)

BOLAW Building Ordinance or Law Coverage

BURMN Burglary & Robbery (Money)

BIAOL Business Income Any Other Location

BUSPR Business Property

CAMFL Camera Floater

CCCLL Care, Custody 0r Control Legal Liability

CHNUR Church with Day Nursery (BOP Only)

COLAP Collapse Coverage Endorsement

COLPD Collapse Property Damage

COLL Collision

CDW Collision Deductible Waiver

CACOV Combined Additional Coverages

BOLCC Combined Building Ordinance or Law and Increased Cost of Construction

BOLDC Combined Demolition Cost and Increased Cost of Construction

Table 5: ThazarCoverCd (Continued)

Code Description
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CCAFL Commercial Fine Arts Floater

CUMBR Commercial Umbrella

COMBI Completed Operations Bodily Injury

COMPD Completed Operations Property Damage

COMP Comprehensive

XCBUL Comprehensive Business Liability Exclusion (BOP Only)

CONEO Consultants Errors & Omissions

PPEQK Contents - Earthquake

BPP Contents (Personal Property)

CNBUS Contingent Business Income

CEQFL Contractor's Equipment Floater

CL Contractual Liability

COC Course of Construction

CCF Credit Card Forgery

CDTCD Credit Card Forgery & Counterfeit Money Increased Limits

DMGPO Damage to Property of Others

DO Directors & Officers Liability

DOCON Directors and Officers of Residence\Office Condos (BOP Only)

DRPLB Doctors excl. Professional Liability

DRACL Drive Away Collision

DOC Driver of Other Car

DWELL Dwelling (Cov. A)

EAOCC Each Occurrence

EQ Earthquake

ERKSP Earthquake - Sprinkler

ERQKF Earthquake and Flood (Mobile Homes)

Table 5: ThazarCoverCd (Continued)

Code Description
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EQSL Earthquake Sprinkler Leakage

ELP Economic Loss Protection

EDPEQ EDP Equipment

EEFL Electronic Equipment Floater

EBLIA Employee Benefits Liability

EMPDH Employee Dishonesty

ERISA Employee Retirement Income Security Act

EL Employer's Liability

XEMP Employment Related Practices Exclusion (BOP Only)

ENGEO Engineers Errors & Omissions

EQDFL Equipment Dealer Floater

EQPFL Equipment Floater

ERROM Errors and Omissions

EXBFL Exhibition Floater

EXFSH Exhibition, Fair, Show

EXP Explosion

EXPBI Explosion Bodily Injury

EXPPD Explosion Property Damage

EE Extra Expense

EXMED Extraordinary Medical Payment

FPRCO False Pretense Coverage

FCPL Farmers CPL

FILFL Film Floater

FIART Fine Arts Floater

FAINT Fine Arts in Transit

FIRE Fire

Table 5: ThazarCoverCd (Continued)

Code Description
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PFRTH Fire & Theft

FIRDM Fire Damage

FLL Fire Legal Liability

FTHWD Fire, Theft, Windstorm

FPB First Party Benefits

FLOOD Flood

FPDFL Floor Plan Dealer Floater

FOOD Food Spoilage

FORRE Foreign Reparations Expense & Increased Limits

FORGN Foreign Workers Compensation Coverage

FORMA Form A

FORMB Form B

FORMC Form C

FORMD Form D

FORME Form E

FORMF Form F

FORMG Form G

FORMH Form H

FORMI Form I

FORMJ Form J

FORMM Form M

FORMN Form N

FEB Funeral Expense Benefits

FURFP Fur Floater (personal lines)

FURFL Furriers Floater

GARBC Garage Broadened Coverage

Table 5: ThazarCoverCd (Continued)

Code Description
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GCOLL Garage Collision

GCOMP Garage Comprehensive

GFIRE Garage Fire

GFRTH Garage Fire & Theft

GLIAB Garage Liability

GLSP Garage Limited Specified Perils

GMEDP Garage Medical Payments

PERIN Garage Personal Injury

GPERL Garage Specified Perils

TEMLL Garage Temporary Location Limit

GTHFT Garage Theft

TRANL Garage Transit Limit

DIREB Garagekeepers Direct Excess Basis

DIRPB Garagekeepers Direct Primary Basis

GKLLI Garagekeepers Legal (BOP Only)

LGLLI Garagekeepers Legal Liability

GASP Gas Pump Liability

GL General Liability

GCM General Liability Claims Made

GLASS Glass

GLABR Glass Breakage

GOLFL Golf Floater

GOLF Golfcart Physical Damage

GRPRP Grain Properties

GUNFL Gun Floater

HNA Hired/Non-Owned Automobile Combined

Table 5: ThazarCoverCd (Continued)

Code Description



General Business Rules

63

HHCPL Home Health Care Professional Liability

HABCD Homeowners Form 7

HOPRL Hospitals Professional Liability

HULMT Hull and Motor

HULL Hull Coverage - Physical Damage

HURR Hurricane

HSCRB Hurricane Buy Back Coverage for Screened Enclosures

GLASH Hurricane Resistant Glass

FRAUD Identity Fraud Expense Coverage

IAADD Improvements Alterations and Additions

ITRST In Transit

IHBUS In-Home Business Coverage

INTFL Installation Floater

INSFL Installment Sales Floater

JWRFL Jewelers Floater

JEWFC Jewelers Floater (commercial inland marine)

JWYFL Jewelry Floater

JEWFP Jewelry Floater (personal inland marine)

LNDMV Land Movement

LEADC Lead Contamination

LEAD Lead Liability

LEADX Lead Liability Exclusion

GAP Lease/Loan Gap

LRCCC Leasing or Rental Concerns - Contingent Coverage

LIAB Liability

GOAO Liability - Garage Operations Auto Only

Table 5: ThazarCoverCd (Continued)

Code Description
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GOOTA Liability - Garage Operations Other than Auto Only

LLL Liquor Law Legal Liability

LIQUR Liquor Liability

LAP Loss Assessment Property

LAPEQ Loss Assessment Property (Inc. Earthquake/Volcanic Eruption)

LRRC Loss of Rental Income - Replacement Cost

LUSE Loss of Use

BOIMB Machinery Breakdown

MEDEX Medical Expense

MEDPM Medical Payments

MEXCO Mexico Coverage

MINS Mine Subsidence

MINP Minimum Premium

MIMFL Miscellaneous Inland Marine Floater

MILLI Miscellaneous Legal Liability

MSEC Money & Securities

MSOFF Money & Securities Off Premises

MSECP Money & Securities on Premises

MTCFL Motor Truck Cargo Floater

MIDFL Musical Instrument Dealers Floater

MUSFL Musical Instrument Floater

NBUSL Non Business Liability (BOP Only)

BOLEQ Ordinance or Law Coverage Earthquake

VACCL Ordinary Vacancy Clause

OTC Other Than Collision

WCRFT Owned Watercraft Liability

Table 5: ThazarCoverCd (Continued)

Code Description
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OCP Owners Contractors Protective

PDNM Pattern, Dies and Molds

PS Peak Season (Old Plan)

PIADV Personal and Advertising Injury

PAFLO Personal Articles Floater

PIHOM Personal Injury

PIP Personal Injury Protection

PL Personal Liability

PP Personal Property

PPAEC Personal Property - Additional Extended Coverage

PPEC Personal Property - Extended Coverage

PPFL Personal Property - Fire and Lightning

PPAOL Personal Property Any Other Location

PPEFT Personal Property Exhibition, Fair, Tradeshow

PPRFL Personal Property Floater

PCL Personal Umbrella

PFIRE Physical Damage Fire

PHYFL Physician Surgeon Equipment Floater

PULBB Pollution Buy Back

POLUT Pollution Liability

PLIAB Premises Liability

LIABA Premises Liability Additional Locations

PREM Premises/Operations 

PEROM Printers Errors & Omissions

PROFL Processing Floater

PRDBI Products Bodily Injury

Table 5: ThazarCoverCd (Continued)

Code Description
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PRDPD Products Property Damage

PRDCO Products/Completed Operations

PRFBI Professional Bodily Injury

PROF Professional Liability

PRFPD Professional Property Damage

PD Property Damage

PDBY Property Damage Buy Back

PPI Property Protection Insurance

PRML Property Removal

FORMP Public Employee Dishonesty - Per Employee

FORMO Public Employee Dishonesty - Per Loss

PRPAI Public Relations Personal & Advertising Injury

PUBEO Publisher Errors & Omissions

PUNI Punitive Damage

RTVFL Radio-Television Policy Floater

RRPRL Railroad Protective Liability

REAEO Real Estate Agents Errors & Omissions

RLESO Real Estate Operations

RENL Renewal Plan

BOIRT Rental Income

RREIM Rental Reimbursement

RENTV Rented Vehicles

RR Repair/Replacement

RCC Replacement Cost Contents

RESPR Residence Premises 3 or 4 Family Dwell.

RJUA Residence Property and Casualty Joint Underwriting Association

Table 5: ThazarCoverCd (Continued)

Code Description
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RCCMT Riot and Civil Commotion

FORMQ Robbery/Safe Burglary - Money and Securities

SLSMP Salespersons Samples

SCHPP Scheduled Personal Property

2NDIN Second Injury Fund

SDB Sewer or Drain Backup

SIGN Sign

CPIP Single Limit PIP

SINK Sinkhole Collapse

SNOWM Snowmobile

SNOWL Snowmobile Liability

SORCV Sound Receiving

SOUND Sound Receiving & Transmitting Equip.

SPCDT Special (Including theft) - Detail

SPE Special Equipment

SPPP Special Personal Property

SPPRV Special Provisions

SCL Specified Causes of Loss

PERIL Specified Perils

PERTI Specified Perils with Trailer Interchange

SPOIL Spoilage

SL Sprinkler Leakage (Old Plan)

STAFL Stamp Floater

STOPG Stopgap

STK Storekeeper Liability

SWMPL Swimming Pool

Table 5: ThazarCoverCd (Continued)

Code Description
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TR Tapes and Records

THEFT Theft

XPOLU Total Pollution Exclusion (BOP Only)

TL Towing and Labor

TRANS Transit

TRNFL Transit Floater

TRNFC Transit Floater (commercial inland marine)

TRNFP Transit Floater (personal inland marine)

TRNEX Transportation Expense

TRLIA Truckers Liability

USLH U.S. Longshore & Harbor Workers' Compensation Act

UMBRL Umbrella

UNDBI Underground Bodily Injury

UDRPD Underground Property Damage

UNDUM Underinsured Motorist Liability

UNDPD Underinsured Motorist Property Damage

UEFS Uninsured Employers Fund

UM Uninsured Motorist

UNK Unknown

VAC Vacancy

PAPER Valuable Papers

VMM Vandalism

VOL Voluntary Comp

SEWER Water Backup of Sewers & Drains

WDE Water Damage Extension

WATER Watercraft

Table 5: ThazarCoverCd (Continued)
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THAZARLOBSUBCD:

WINDX Wind Exclusion

WIND Wind/Hail

WNDST Windstorm

WJUA Windstorm Underwriting Association

WCEL Workers Comp and Employer's Liability

Table 5: ThazarCoverCd (Continued)

Code Description

Table 6: ThazarLOBSubCode  

Code Description

ARP Assigned Risk Plan

AUTL Business Automobile Liability (for Loss History)

AUTP Business Automobile Physical Damage (for Loss History)

CGL Comprehensive General Liability

CNTB Contract Bonds

CNTR Contractual

CRFD Court and Fiduciary Bonds

CRT Court Bonds

DISC Discovery

FRPS FAIR Plan (Subcharged)

FRPU FAIR Plan (Unsurcharged)

FIDU Fiduciary Bonds

FSB Florida Sub-Standard

GARAG Garage and Dealers

GCM General Liability Claims Made

INRV Internal Revenue Bonds
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LCPT License and Permit Bonds

LP License Bonds

LSUD Loss Sustained

MANC Manufacturers and Contractors

MASS Massachusetts Automobile

MSCB Miscellaneous Bonds

NOND Named Non-Owned

NPC New Plan - Claims Made

NPO New Plan - Occurrence

NSTD Non-Standard Automobile

OCCUR Occurrence

OLT Owners, Landlords and Tenants

OCP Owners/Contractors Protective

PROD Products/Completed Operations

PROF Professional Liability

PO Public Official Bonds

FAC Reinsurance Facility

SPEC Special Automobile

STOR Storekeepers

SUB Sub-Standard Automobile

TXAR Texas Assigned Risk Automobile

TXFR Texas Fire

TXHO Texas Homeowner

TXVL Texas Voluntary Automobile

US United States Bonds

VOL Voluntary

Table 6: ThazarLOBSubCode  (Continued)

Code Description
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WARE Warehouse Bonds

Table 6: ThazarLOBSubCode  (Continued)

Code Description
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